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OVERVIEW 
 
 
This Study Guide is designed to familiarize you with the digital communications and computer 
knowledge and skills required by BellSouth’s technical jobs and covered by the Digital 
Communications and Computer Literacy Test.  It will also familiarize you with the test, help you 
decide if you’re ready to take it, and guide your preparation if you’re not ready at this time. 
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PART 1:   TEST DESCRIPTION 
 
What is the purpose of the Digital Communications and Computer Literacy Test? 
 

To measure your knowledge and ability to apply concepts, terms, and principles involved 
in working on or near electrical and electronic equipment.  Although the test contains 
some factual questions, it emphasizes your understanding of the subject and your ability 
to apply what you know, not just your memory for facts or formulas. 

 
Who has to take it? 

 
Candidates for certain BellSouth technical jobs are required to qualify on this test.  
Although there are no prerequisites for taking the Digital Communications and Computer 
Literacy Test, if you have no prior training or work experience in dealing with alternate 
numbering systems, fiber optics, digital transmission, computers, and emerging 
technologies, you probably will not do well on the test.  
  

What kind of test is it?   
 

It is a 60-question multiple choice test.  Each question has 4 possible answers to choose 
from (a, b, c, d).  Some questions refer to figures.  These will be provided to you in a 
printed Reference Booklet. 

 
How do I take the test? 
 

In some locations, the test is given on a PC.  Questions appear on the screen like this: 
 
Q:   RAM stands for: 
 

a.  Read Alternate Memory 
b.  Repeated Automatic Maintenance 
c.  Read Accelerated Module 
d.  Random Access Memory 

 
(Next Question) 

 
 

Just touch the screen to indicate the answer you think is correct, answer “d” in the sample 
question above.  When you’re ready for the next question, you press “Next Question” at 
the bottom of the screen.  You can change your answers as many times as you wish, go 
back to an earlier question, or review the entire test.  You will have 60 minutes to finish. 
 
In other locations, the test is given in a printed test booklet.  You are asked to record your 
answers on a Scantron form using a #2, or HB, pencil.  
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Will I have to do any calculations? 
 

Yes, but you can use a calculator.  You may bring a calculator that is silent, handheld, and 
battery operated.  It cannot be solar or have alpha characters on the keypad.  The 
calculator you bring should be able to perform the following functions:  Addition, 
Subtraction, Multiplication, Division, and Power functions.  A scientific calculator can 
perform these functions. 

 
How is my score determined? 
 

Your score will be the number of questions you answer correctly.  There’s no penalty for 
guessing, so try to answer every question. 

 
 
What happens if I don’t pass? 
 

If you take the test but do not score high enough to qualify, you will have to wait for a 
specified period, determined by BellSouth, before taking the test again. 

 
 
What does the Digital Communications and Computer Literacy Test cover?  
 

It covers six main subject areas: 
 

• = Binary Basics 
• = Fiber Optics 
• = Digital Transmission 
• = Networks-LANs and WANs 
• = Emerging Technologies 
• = Critical Thinking Skills 

 
In addition, you need to know: 

 
• = Applied Math 
• = How to Use a Scientific Calculator 
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What exactly do I have to know? 
 
Here is a list of the specific knowledge and skills the test covers.  If you know and understand 
these things and can apply what you know, you should do well on the test.  

  
1. Binary Basics Knowledge and Skill Requirements 

�Conversions—Hex to Dec, Bin to Hex, etc. 
�Binary Math—addition, subtraction, etc. 
�Logic gates—AND, OR, NOR, etc. 

 
2. Fiber Optics Knowledge and Skill Requirements  

�Types—single-mode, multi-mode, etc. 
�Connectors and splices 
�Sources and detectors 
�Impairments—attenuation and dispersion 
�Basic link budgets 
�OTDR measurements 

 
3. Digital Transmission Knowledge and Skill Requirements  

�Multiplexing and time slot interchange 
�Synchronization and timing 
�Line codes and Modulation Techniques 
�Bandwidth, bit rate, Baud rate, etc. 
�T-carriers—hierarchy, overhead, framing, data rates, etc. 
�SONET—hierarchy, overhead, framing, data rates, etc. 

 
4. Networks—LANs and WANs Knowledge and Skill Requirements  

�OSI 7-layer model 
�Protocols—TCP/IP, Ethernet 
�Equipment functions—repeaters, bridges, switches and routers 
�The Internet—access techniques and terminology 
�Computer skills—using windows, saving files, using Telnet and FTP, etc. 

 
5. Emerging Technologies Knowledge and Skill Requirements 

�ATM—overhead, layers, addressing, QoS, etc. 
�Frame Relay—overhead, framing, addressing, etc. 
�ISDN—PRI and BRI, line codes, data rates, etc. 
�XDSL (HDSL, ADSL, etc.) and Cable modems—line coding and modulation, limitations 

and data rates 
 
6. Critical Thinking Skills 
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What exactly do I have to know? (continued) 
 
Applied Math: Knowledge and Skill Requirements 

• = Add, subtract, multiply, and divide whole numbers and decimals 
• = Manipulate positive and negative numbers 
• = Manipulate powers of ten 

 
Use of a Scientific Calculator: Knowledge and Skill Requirements 

• = Store and recall values in memory 
• = Calculate using exponents 

 
 
What will enhance my probability of success? 
 

Although there is no “one” set of skills and experiences that you need to have in order to 
pass the test, having certain knowledge, skills, and experiences will enhance your ability 
to understand the DCCL material.  To enhance your probability of success, candidates 
should have:   

 

• = At least minimal knowledge and understanding of Basic Electricity and Basic 
Electronics 

• = Base knowledge of electricity and electronics terms (e.g., voltage, current, decibel, 
resistance, power, circuit, capacitance, inductance, reactance, multimeter, diode, 
transistor) 

• = Knowledge of how to use a scientific calculator 
• = Knowledge of how to work a formula 
• = Knowledge of applied math 
• = Knowledge of basic components and operations of a computer 

o Hardware – (e.g., storage, memory, file types, file management) 
o Software – (e.g., Word, Excel) 
o Familiarity with the Internet and Internet terminology 

 
In addition, having a technical background or previous technical experience would be 
helpful. 
 
If you are an employee, you are encouraged to review the DCCL correspondence course 
materials even if you take an instructor led course. 
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PART 2:   SELF-ASSESSMENT 
 
 
 
This section contains a practice test of 25 questions that are similar to the questions on the real 
test.  To find out how ready you are to take the real Digital Communications and Computer 
Literacy Test: 
 

1. Take the practice test. 
 
2. Use the key on page 13 to score it. 
 
3. Review the explanations, starting on page 14, for questions you missed or were   

unsure of. 
 
4. Look up your score on page 18 to see how well you are likely to do on the real test.   

 
 
Practice Test Instructions 
 

• = You will need this Study Guide, paper and pencil, and a calculator able to perform the 
 following functions:  Addition, Subtraction, Multiplication, Division, and Power 
 functions. 

 
• = Read each question carefully.   

 
• = Use the Reference Sheet on page 12 to find the figure you will need.   

 
• = Pick the best answer for each question and write the letter of your answer on a piece of 

paper.   
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Practice Test  
 
1. Refer to Figure 1. 

Which of the following inputs would have to change in order for K to change 
state? 
a.  A or B 
b.  B or C 
c.  C or A 
d.  D or C 
 

2. The company which provides you with a connection to the Internet via either a 
Dial-up Connection or a Direct Connection is called a(n): 
a.  WAIS 
b.  IRC 
c.  BPS 
d.  ISP 
 

3. ATM and Frame Relay are referred to as “Fast Packet” technologies.  At which 
layer of the OSI 7-layer model do these technologies work? 
a.  Data link 
b.  Network 
c.  Session 
d.  Transport 
 

4. In a SONET network, which of the following is a function of the Line 
Overhead? 
a.  Automatic Protection Switching 
b. Frame alignment pattern 
c.  Repeating 64-byte message 
d.  Structure of Synchronous Payload Envelope 
 

5. Which of the following is most similar in function to an Ethernet LAN switch? 
a.  Bridge 
b.  Gateway 
c.  Repeater 
d.  Router 
 

6. The most common distance-limiting factor for multi-mode fiber when carrying 
high bit-rate traffic is 
a.  Attenuation loss 
b.  Chromatic dispersion 
c.  Fresnel loss 
d.  Modal dispersion 
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7. Which of the following modulation schemes provides 4 bits per baud? 
a.  QPSK 
b.  8-PSK 
c.  16-QAM 
d. 64-QAM 
 

8. Perform modulo 2 addition of 100110 and 011101.  What is the result? 
a.  111011 
b.  110111 
c.  000011 
d.  000100 
 

9. Which term represents information and overhead at the Transport layer in the 
OSI 7-layer model? 
a.  Sessions 
b.  Segments 
c.  Frames 
d.  Packets 
 

10. Which of the following is defined under the Broadband ISDN standards? 
a.  ATM 
b.  BRI ISDN 
c.  PRI ISDN 
d.  SMDS 
 

11. What is the term for a device that combines several sources into a single bit 
stream with a data rate that is less than the combined data rates of all input 
sources? 
a.  Time division multiplexer 
b.  Inverse multiplexer 
c.  Add-drop multiplexer 
d.  Statistical time division multiplexer 
 

12. Inverting the inputs of an AND gate gives the same result as inverting the 
output of which of the following? 
a.  an AND gate 
b.  an OR gate 
c.  an X-OR gate 
d.  a NOR gate 
 

13. A multi-mode fiber has a bandwidth of 250 MHz-Km.  How far can a 1.25 GHz 
signal be reliably transmitted using this fiber? 
a.  200 meters 
b.  250 meters 
c.  2000 meters 
d.  5000 meters 
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14. What is a cookie? 
a. The unique name that identifies an Internet site 
b. An Internet software tool for locating people on other Internet sites 
c. A set of data that a website server gives to a browser the first time the user 
visits  the site, that is updated with each return visit. 
d. A hardware or software setup that translates between two dissimilar protocols 
 

15. What is the term for a device that allows for high data rate access at a customer 
location by distributing the data over several T-1 carriers? 
a.  Time division multiplexer 
b.  Digital cross-connect switch 
c.  Inverse multiplexer 
d.  Channel service unit 
 

16. The conversion of the decimal number 57 to its binary equivalent is equal to: 
a.  111001 
b.  110111 
c.  110011 
d.  101111 
 

17. TCP residing in the receiving host will send an acknowledgement for which of 
the following? 
a.  Frame 
b.  Packet 
c.  Segment 
d.  Session 
 

18. Three foot cable sections that normally cost $79 each are on sale at 2 for $150. 
How much can be saved by purchasing 20 cable sections at the sale price? 
a.  $40 
b.  $160 
c.  $120 
d.  $80 
 

19. As a ray of light moves away from the center of a multi-mode, graded index 
fiber, which of the following statements is true? 
a.  Light will be absorbed by cladding 
b.  Light will be reflected by cladding 
c.  Velocity of light will decrease 
d.  Velocity of light will increase 
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20. Which of the following statements regarding the difference between a 
superframe (SF) and an extended superframe (ESF) in a T-1 carrier is NOT 
true? 
a.  Both SF and ESF use A,B,C and D signaling bits 
b.  A SF is made up of 12 frames, an ESF is made up of 24 frames 
c.  An extended superframe includes a CRC function, a SF does not 
d.  An ESF conveys less frame synchronization information than a SF 
 

21. In Microsoft Excel, how does one keep the heading from scrolling when 
viewing a spreadsheet with many rows? 
a. ‘Split’ from ‘View’ menu 
b. ‘Freeze Panes’ from ‘Window’ menu 
c. ‘Heading’ from ‘View’ menu 
d. ‘Heading’ from ‘Window’ menu 
 

22. Subtracting the binary number 1111 from 11111 gives: 
a.  01111 
b.  10000 
c.  10001 
d.  10111 
 

23. Which of the following technologies employs a Distributed Queue Dual Bus 
(DQDB) architecture? 
a.  ATM 
b.  FDDI 
c.  SMDS 
d.  SONET 
 

24. Which of the following is not a field contained in a Frame Relay frame header? 
a.  Committed Information Rate (CIR) 
b.  Command/Response (CR) Indication 
c.  Extended Address (EA) 
d.  Forward Explicit Congestion Notification (FECN) 
 

25. Which drive is most commonly referred to as the floppy drive? 
a.  A: 
b.  B: 
c.  C: 
d.  D: 
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Figure 1. 
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Scoring the Practice Test 
 
 

1. Use the key answers given below to score your Practice Test.   
 

1. D  11. D  21. B 
2. D  12. B  22. B 
3. A  13. A  23. C 
4. A  14. C  24. A 
5. A  15. C  25. A 
6. D  16. A    
7. C  17. C    
8. A  18. D    
9. B  19. D    

10. A  20. A    
 
 
2. Count the number of questions you answered correctly.  This is your total score. 
 
3. Make a list of the questions you missed or got right but were unsure of.  Review the 

explanation of those questions on the following pages. 
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Explanation of Practice Test Questions 
 
1-D The initial output state at the last AND gate (I and J are inputs and K is output) is 0.  This 

is because I = 0 and J = 1.  Since it is an AND gate, both inputs must be 1 for the output 
to change from 0 to 1.  The only inputs that will allow for this are C or D inputs. 

 
2-D ISP is the acronym for Internet Service Provider. 
 
3-A ATM and Frame Relay are called “Fast Packet” because they were developed to replace 

the older X.25 packet technique.  X.25 works at the Network layer of the OSI model.  It 
has a high amount of overhead for error recovery in a noisy transmission environment.  
Using modern fiber optic facilities the extra overhead is not necessary, so “Fast Packet” 
technologies were developed to work at the Data Link layer (a lower layer), with less 
processing required.  The lower amount of processing for error control makes ATM and 
Frame Relay faster.  

 
4-A SONET networks provide overhead for Path, Line and Section functions.  Some of the 

functions of Line overhead are Parity Checking, Data Comm. Channel, Orderwire, and 
Automatic Protection Switching. 

 
5-A   Ethernet LAN switches work at the Data Link layer of the OSI 7-layer model.  They are 

fast switching devices that have taken the place of bridges in LANs.  Bridges also work 
at the Data link layer and perform the same function—segmenting a LAN.  A 
repeater works at the physical layer and Router and Gateways work above the Data link 
layer. 

 
6-D Multi-mode fiber gets its name from the way light propagates through the core.  The light 

takes many modes (paths) through the core.  The shortest path is the axial mode—directly 
through the center.  The other paths are longer because the light reflects off the sides of 
the core.  This difference in path length causes the light signal to “smear” (or disperse) 
over distance, causing the bits to overlap at the receiver.  The spreading of the signal due 
to different paths through the core is called Modal Dispersion.  It becomes the limiting 
factor as the data rate increases. 

 
7-C The signaling rate (baud rate) of a channel is a function of the bandwidth of the channel.  

The bit rate is a function of the number of bits that can be represented by a baud.  The 
number of signaling points used by a modulation scheme determines the number of bits 
per signaling change.  Using 16 possible combinations of phase and amplitude, 16-QAM 
(Quadrature Amplitude Modulation) can represent any of the 16 possible combinations 
of 4 bits, from 0000 to 1111, with each signaling change. 
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8-A Modulo-2 addition is a binary form of addition that is  
logically the same a Exclusive–ORing.   
Refer to the truth table for Modulo-2 addition. 

 
 
 
9-B As a Protocol Data Unit (PDU) moves through each layer of the 7-layer model, it is 

processed according to the function of the specific layers.  The PDU is provided a unique 
name at certain layers.  Example:  At layer 1, the physical layer, the PDU is referred to as 
“bits”.  At the Transport layer the PDU is called a “Segment”. 

 
10-A Both ATM and SONET are defined under the Broadband ISDN standards.  Basic 

Rate Interface (BRI) and Primary Rate Interface (PRI) area considered Narrow-band 
ISDN. 

 
11-D A multiplexer is a device that combines several sources into a single data stream.  A 

Statistical multiplexer does this in an efficient manner by sizing the bit stream based on 
the actual traffic generated by each source instead of the total of each source’s bit rates.  
So, using a statistical multiplexer, the size of the bit stream will always be less than the 
combined data rates of the sources. 

 
12-B Refer to the truth table comparing an AND gate and an AND gate with inverted inputs 

to output of other gates.  A and B are inputs and C is the output. 
 

AND Gate output OR Gate output X-OR Gate output  
Inputs Normal Inverted inputs Normal Inverted output Normal Inverted output 
A B C C C C C C 
0 0 0 1 0 1 0 1 
0 1 0 0 1 0 1 0 
1 0 0 0 1 0 1 0 
1 1 1 0 1 0 0 1 

 
The only match with an AND gate having inverted inputs is an OR gate with inverted outputs. 
 
13-A The MHz-Km value of an optical fiber is a statement of bandwidth for a given distance.  
So, a 250 MHz-Km optical fiber can reliably transport a 250 MHz signal one kilometer.  As the 
bandwidth increases, the distance decreases.  Since 1.25 GHz is five times the stated 
bandwidth, the distance will be one fifth of a kilometer—200 meters.  
 
14-C Answer C provides a simple definition of the term “cookie”. 

Modulo-2 Addition 
Operation Result 

0 + 0 0 
0 + 1 1 
1 + 0 1 
1 + 1 0 
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15-C When a customer has a requirement to transport information at a rate higher than a T-1 
(1.544 Mbps), the next step in service offerings is a T-3 (44.736 Mbps).  This is a big 
increase in bit rate and cost.  A less expensive alternative to a T-3 is using multiple T-1s 
and distributing the customer traffic across them.  The equipment used for this purpose is 
called an “inverse multiplexer” because instead of combining several inputs into one 
output (multiplexing), the one customer input is distributed over several T-1s.  This is a 
very cost-effective approach for data rates greater than a T-1 but significantly less than a 
T-3. 

 
16-A The procedure for converting from decimal to binary is called successive division.  In 

this process, the decimal number (57 in this case) is divided by two and a test for a 
remainder is performed.  The process continues until 1 is divided by 2.  The test value is 
the binary number from Least Significant Digit to the Most Significant Digit.  

 
In this case:  111001 

 
 
 
 
 
 
 
17-C Refer to question 9 regarding PDU names at each level of the 7- layer model.  TCP is a 

Transport layer protocol.  It is connection-oriented, meaning that it provides for reliable 
service.  TCP acknowledges for Segments.  Segment is the name for a PDU at the 
Transport layer. 

 
18-D Purchasing 20 cable sections at the individual price would be 20 ⋅ $79 = $1580.  

Purchasing the 20 cable sections at a price of 2 for $150 would be 10 ⋅ $150 = $1500.  
The difference in cost would be $80. 

 
19-D A graded index multi-mode optical fiber guides light differently from a step index multi-

mode fiber.  Instead of having an abrupt change in refractive index (R I) between the core 
and cladding, as with step-index multi-mode fiber, graded index has a high refractive 
index at the center of the core and a gradual reduction of the refractive index away from 
the center of the core.  A higher R I at the center of the core means that as light moves 
away from the core it travels faster due to the reduction in the R I. 

 
20-A A Superframe is a sequence of 12 frames using bits in the 6th and 12th frames for 

signaling purposes.  These signaling bits are called A (6th frame) and B (12th frame) bits.  
Extended Superframe uses a 24 frame sequence, so it has A, B, C and D signaling bits. 

 
21-B In Microsoft Excel, if you have a spreadsheet with many rows and want to be able to 

scroll through the rows while still maintaining column headings, you would place your 
cursor directly below the row you want to “freeze” and select the ‘Freeze Panes’ 
command from the ‘Window’ menu. 

Operation Result Test for Remainder 
(yes = 1, no = 0) 

57 ÷ 2 28 1  LSD 
28 ÷ 2 14 0 
14 ÷ 2 7 0 
7 ÷2 3 1 
3 ÷ 2 1 1 
1 ÷ 2 0 1  MSD 
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22-B A technique for binary subtraction is called 1s complement.  This technique is illustrated 
below.  The 1s complement of a binary number is the inverted value of the binary 
number. 

 
Step 1. Perform the 1s complement of the subtrahend.  In this case the subtrahend is 

01111 (left-most position is filled in to match the number of positions in the 
minuend), so the 1s complement will be 10000. 

Step 2. Perform binary addition.  Remember:  A 1 + 1 in binary addition will produce a 0 
and a carry to the next position. 

Step 3. The left-most carry is brought down (as shown) and a second addition is 
performed.  Notice that the small 1s are a carry from the last addition step. 

 
             Step 1  Steps 2 and 3 
In this example, 11111 – 01111 = 10000 

 
 
 
 
 
 
 
23-C The Distributed Queue Dual Bus (DQDB) is a Metropolitan Area Network (MAN) 

protocol standard described in IEEE 802.6.  Switched Multi-megabit Data Service 
(SMDS) is a MAN service that uses DQDB. 

 
24-A The following is a list of the fields in a Frame Relay header.  
 

 Fields in a Frame Relay Header 
�Data Link Connection Identifier (DLCI) 
�Command/Response (C/R) 
�Extend Address (EA) 
�Forward Explicit Congestion Notification (FECN) 
�Backward Explicit Congestion Notification (BECN) 
�Discard Eligibility (DE) 

 
A Frame Relay Header does not contain a Committed Information Rate (CIR).  CIR 
is the basic level of tariffing of Frame Relay services in the public network. 

 
25-A Although all of the options listed could be referred to as a floppy drive, drive A is most 

commonly referred to as the floppy drive.  Drive B is less commonly referred to as the 
floppy drive.  Drive C is often referred to as the hard drive.  Drive D is often referred to 
as the CD-ROM drive, but can also be used as a hard drive. 

 

1+
1111

1  0  0  0 0

1  0  0  0 0(subtrahend)
(minuend)

+
1  1  1  1 1

0  1  1  1 1
+ 1  0  0  0 0

0  1  1  1 1

1  1  1  1 1
carry 1
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How Did I Do? 
 
The Practice Test questions are very similar to—but not the same as—the questions you’ll see on 
the real test.   Your Practice Test score will give you a good idea of how well you could expect to 
do on the real test but, of course, only your score on the real test counts. 
 
Find your score level in the table below to get a good idea of how well prepared for the test you 
are right now.  
 
 
 

If your Practice Test score was . . . 
 

 then  . . . 

20 – 25  Congratulations!  You are ready to take the real 
test and should have an excellent chance of 
qualifying.  Get ready for the test with the help 
of the hints in Part 3. 
 

15 – 19 
 
 

 You did pretty well but are probably a little 
rusty in some areas.  If you took the real test 
now, you would have a fair chance of 
qualifying.  You can improve the odds if you 
review your weak areas first.  See Part 3. 
 

10 – 14 
 

 Although you know some of the material, your 
score indicates that there are some subjects that 
you’ve never studied or haven’t worked with in 
quite a while.  Use Part 3 to plan a study 
strategy. 
     

0 – 9 
 

 You do not know the material well enough to 
prepare on your own.  If you’re still interested 
in taking the test, you might want to take a 
course that covers many of the knowledge and 
skill areas listed on pages 5-6.  You also may 
find the information in Part 3 valuable in 
helping you prepare for the test.   
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PART 3:   TEST PREPARATION 
 
Tips for Studying on Your Own 
 
If you have some experience in this field or have already taken a course, perhaps some time ago, 
you should plan a study strategy. 
 

1. Identify Your Weak Areas 
 

• = Re-read the explanations in Part 2 for any Practice Test questions you missed.   
 
• = Read through all the knowledge and skill areas listed on pages 5 – 6.   
 
• = Mark the areas in which you have no training or work experience and the ones 

related to the practice questions you missed or didn’t understand. 
 
 

2. Find a Textbook or Website 
 

• = Look for books and websites that cover the subjects you need.   
 
• = Books and websites that have practice problems and exercises to let you check your 

understanding are the best. 
 

• = The following pages provide some examples of books and websites that you may 
find useful in helping you study.  However, the list is not meant to be exhaustive.  
Moreover, since websites change frequently, you are encouraged to find other books 
and websites that address the knowledge and skill areas provided on pages 5-6 of 
this study guide.    

 
3. Study 

  

• = Identify the sections you need to study. 
 

• = Concentrate on one section at a time.   
 

• = Work the problems and do the exercises.   
 

• = If you have trouble with a topic, read the material again.  If you still have trouble, 
find another source of information.  A new explanation often helps.  

 
4. Check Your Progress 

 
• = Take the Practice Test again or answer the review questions contained in your book or 

on a website. 
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Books for Digital Communications and Computer Literacy 
 

 
Digital Networking and T-Carrier Multiplexing by Gilbert Held 
John Wiley & Sons  1990 
ISBN:  0 471 92800 3 

�Line Codes 
�T-Carrier:  framing, coding and multiplexing 

 
SONET and T-1:  Architectures by Uyless Black and Sharleen Waters 
Prentice Hall  1997 
ISBN:  0 13 447590 9 

�T-1 Carriers 
�SONET:  hierarchy, overhead, payload mapping, equipment and topology 
�Fiber Optics:  types, sources/detectors, connectors and impairments  

 
Fiber Optics Technician’s Manual by Jim Hayes 
Delmar Publishers  1997 
ISBN:  0 8273 7426 7 

�Fiber Optics:  types, connectors, splices, installation and testing  
 
High Speed Networks by M. Boisseau, M. Demage and J-M. Munier 
John Wiley & Sons  1994 
ISBN:  0 471 95109 9 

�OSI reference model 
�Bandwidth, bit rate and modulation rate 
�LANs: media, framing and protocols 
�Transmission:  multiplexing, T-Carriers and SDH/SONET 
�Switching Technologies:  Circuit, Packet (X.25), ISDN, Frame Relay and Cell Relay 

(ATM) 
�Networks:  Protocols (TCP/IP), Bridges and Routers 

 
Emerging Communications Technologies by Uyless Black 
Prentice Hall 1997 
ISBN 0 13 742834 0 

�T-Carriers 
�OSI reference model 
�SONET 
�ISDN 
�Frame Relay 
�ATM 
�Ethernet 
�XDSL (ADSL, HDSL) 
�TCP/IP 
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Websites for Digital Communications and Computer Literacy 
 
Binary Basics Tutorials 
http://www.cs.colorado.edu/~l3d/courses/CSCI1200-96/binary.html 
http://www.cwru.edu/cse/eeap/282/02_binary_numbers.html 
http://web.chem.monash.edu.au/studentweb/tutorials/Lecture_help/binnums.html 
http://www.acad.humberc.on.ca/~ceng103/ 
 
Fiber Optics 
http://homepages.ihug.co.nz/~edhall/fiber/otdr.htm 
http://www.fotec.com/ 
http://www.fotec.com/otdr/otdrs.htm 
http://www.commspecial.com/fiberguide.htm 
http://floti.bell.ac.uk/MathsPhysics/fibreops.htm 
http://www.arcelect.com/fibercable.htm 
 
Digital Transmission 
http://www.rad.com/networks/1994/digi_enc/main.htm 
http://www.rad.com/networks/1995/digcom/digcom.htm 
http://www.ece.wpi.edu/courses/ee535/hwk98/hwk4cd98/yugu/yugu.html 
http://www.iec.org/tutorials/sonet/ 
http://www.ora.com/reference/dictionary/terms/D/Digital_Transmission_Rate_1.htm 
http://www.dspnet.com/TOL/newsletter/rev6/Modulation.html 
 
LANs and WANs 
http://www.rad.com/networks/1997/nettut/mainmenu.html 
http://www.rad.com/networks/1994/transmis/media.htm 
http://www.rad.com/networks/1997/ethernet/overview.html 
http://www.rad.com/networks/1999/tcp/index.htm 
http://oac3.hsc.uth.tmc.edu/staff/snewton/tcp-tutorial/ 
http://www.dcs.uky.edu/~griff/classes/cs471/notes/ch14a/notes/node9.html 
http://jhunix.hcf.jhu.edu/~tnaugler/770.512/Common_files/OsiModel/OSIModel.htm 
 
Computer Skills 
http://www.chass.ncsu.edu/English/computer_tutorial/P_under.htm 
http://www.orst.edu/aw/tutorials/telnet/pctelnet.html 
http://www.kelvin.wsd1.org/tech/tutorial/ 
 
Emerging Technologies 
http://www.rad.com/networks/1999/atm/home.htm 
http://www.rad.com/networks/1994/fram_rel/frame.htm 
http://www.orckit.com/fr_newsa.html?/qam.html 
http://www.adsl.com/adsl_tutorial.html 
http://www.ralphb.net/ISDN/index.html 
http://www.sci.pfu.edu.ru/telesys/studwork/telfut96/Isdn/atm/tute.html#AL 


